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Getting started with Power BI
Microsoft Power BI helps you stay up to date with the information that matters to you. In Power BI, your dashboards
make it easy to open reports that you can explore in detail. Connecting to multiple datasets from Power BI helps you
bring all of your relevant data together in one place.
If you have important data in Excel or CSV files, you can create a Power BI dashboard to stay informed anywhere—
even with mobile devices—and share insights with others. If you’re a data analyst, you’ll find that Power BI is a
powerful, flexible, and highly accessible tool to connect and shape data, build robust models, and craft well-structured
reports.
Start working with your data in Power BI Desktop, which lets you create a collection of queries, data connections, and
reports that can easily be shared with others. Power BI Desktop integrates proven Microsoft technologies—the
powerful query engine, data modeling, and visualizations—and works seamlessly with the online Power BI service.

Power BI service
Power BI is an Office 365 app available to Microsoft full-time employees or contingent staff with a microsoft.com
account. To sign in, go to app.powerbi.com. After you sign in to Power BI, you’ll see the Welcome to Power BI page,
with links to resources for getting started and exploring data.

Figure 1. The Power BI welcome page
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Under Import or Connect to Data, choose the Get button in the Files or Databases boxes to start working with data.
This takes you to your My Workspace page, where you can connect to data in files, databases, data warehouses, or
even import your own content.

Figure 2. My Workspace in Power BI
In your workspace, you can connect to data sources and create reports, dashboards, KPIs, and more.

Dashboards in Power BI
In Power BI, you can create personalized dashboards to view your most important data at a glance. A dashboard
combines on-premises and cloud-borne data in a single pane, providing a consolidated view across the organization
regardless of where the data is stored. Each metric, or insight, is displayed on the dashboard as a tile.

Dashboard tiles
A tile is a snapshot of your data, pinned to the dashboard. You can create a tile from a report, dataset, dashboard,
from the Q&A box, Excel, from SQL Server Reporting Services, and more. The image below shows many different tiles
pinned to a dashboard.

Figure 3. Dashboard tiles
microsoft.com/itshowcase

June 2016

Page 3

|

Getting started with Power BI

In addition to pinning, you can create standalone tiles directly on the dashboard by using the Add tile command at
powerbi.microsoft.com/en-us/documentation/powerbi-service-add-a-tile-to-a-dashboard. Standalone tiles include
text boxes, images, videos, and web content.
NOTE: If the original visualization used to create the tile changes, the tile doesn't change. For example, if
you pinned a line chart from a report and then you change the line chart to a bar chart, the dashboard tile
continues to show a line chart. The data refreshes, but the visualization type does not.

Create a dashboard
This method creates a new, empty, dashboard.
1.

In the left navigation pane in Power BI (the service, not Power BI Desktop), select the plus sign
Dashboards heading.

2.

Type a name for your new dashboard and press Enter.

next to the

The new dashboard is created. You’ll see it listed under Dashboards in the left navigation pane.
3.

Select the new dashboard to make it the active dashboard. Notice that it’s blank—it has no content yet.

Add some content to your new dashboard
There are many different ways to add content to your dashboard. You can:


Connect to or import at least one dataset and pin content from that dataset to your dashboard.



Add standalone content. For example, you can add an image, text box, heading, video, or web content.
TIP: Need some help getting started adding content? Check out Step 1: Get data in the Get started with
Power BI tutorial at powerbi.microsoft.com/en-us/documentation/powerbi-service-get-started.

Get up and running
Ready to get started? Work through the Guided learning for Power BI tutorial at powerbi.microsoft.com/enus/guided-learning. You can find a link to this tutorial and to the Power BI in 60 seconds video when you sign in on
the Power BI home page at powerbi.com.

Do great things with data in Power BI Desktop
With Power BI Desktop, you connect to data, shape that data with queries that build data models, and use those data
models to create reports that others can use, build upon, and share. If you’re a data analyst delivering reports and
analytics to your organization, Power BI Desktop lets you be productive and creative with what you build.
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Power BI Desktop is a feature-rich data mashup and report authoring tool that lets you combine data from databases,
files, and web services using visual tools that help you understand and fix data quality and formatting issues
automatically. With over 20 built-in visuals and a vibrant community of custom visualizations, create stunning reports
that communicate your message effectively.
As you add different sources to your data model, Query Editor detects relationships between tables and keeps track
of the steps you apply to your data—you can even back out of changes you’ve made. After you’ve completed the
steps to your satisfaction—connect, shape, and report—you can save that work in Power BI Desktop file format, which
is the .pbix extension. Power BI Desktop files can be shared like any other file, but the most compelling way to share
Power BI Desktop files is to upload and share them on the Power BI service.

Download and install Power BI Desktop
Before you start using Power BI Desktop, you need to download and install it on your computer. See Get Power BI
Desktop at powerbi.microsoft.com/en-us/documentation/powerbi-desktop-get-the-desktop. After you’ve installed
Power BI Desktop, you can access it from your desktop or the Windows Start screen.

Find and connect to a data source
1.

Start Power BI Desktop.
If you didn’t change any settings when you ran the Power BI Desktop installation, you should see the icon for
Power BI Desktop

2.

on your Windows desktop or Start screen.

On the Home tab, select Get Data to see a list of all available data source types. Notice that the data source
types are separated into five categories: All, File, Database, Azure, and Other.

Alternatively, you can select the down arrow next to Get Data to see a shorter list of commonly used data types.
3.

Select the type of data source you want to connect to, and then follow the steps in the wizard.
The next section of this guide shows you how to create a dynamic connection to an Excel workbook. In another
section, you’ll learn how to connect to data on a web page.
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Other data sources
There are several other data sources available—online services, data warehouses, and more. You’ll see all the choices
when you use the Get Data dialog box to connect to a data source. To see all the tools and techniques available for
connecting to data from Power BI Desktop, expand the “Connect to data” section in the left pane of the online help
article, Getting started with Power BI Desktop at powerbi.microsoft.com/en-us/documentation/powerbi-desktopgetting-started.

Connect to an Excel workbook
1.

In the Get Data dialog box, select Excel, then select Connect.

2.

Browse to your workbook, and then select Open.
The Navigator window appears.

3.

Select the objects in the workbook you want to include in the data connection, such as sheets or tables.
If you select Edit before you load the data, you can perform cleanup operations on your columns of data, such as
filtering, sorting, transforming, or changing the data type. See the section Shaping and combining data for more
information about transforming data.

4.

Select Load.

5.

Select Save As on the File menu to save your data connection as a Power BI file (.pbix file name extension).

Connect to data on a web page
1.

In the Get Data dialog box, select Web.

2.

Enter the path to the web page in the URL box, and then select OK.
The Navigator window appears.

3.

Select the table(s) that you want to include in the data connection.
NOTE: You can ignore the Document object, as it contains only metadata about the web page.
If you select Edit before you load the data, you can perform cleanup operations on your columns of data, such as
filtering, sorting, transforming, or changing the data type. See the next section in this guide for more information
about transforming data.

4.

Select Load.

5.

Select Save As on the File menu to save your data connection as a Power BI file (.pbix file name extension).

Shaping and combining data
With Power BI Desktop, you can connect to many different types of data sources, and then shape the data to meet
your needs. Shaping data means transforming the data—such as renaming columns or tables, changing text to
numbers, removing rows, or setting the values in the first row as column headers. Combining data means connecting
to two or more data sources, shaping them as needed, then consolidating them into one useful query.
When you load data into Power BI Desktop, it attempts to convert the data type of the source column into a data type
that better supports efficient storage, calculations, and data visualization. For example, if a column of values has no
fractional values, Power BI Desktop converts the entire column of data to a Whole Number data type.
When you shape data in the Query Editor, you’re providing step-by-step instructions that Query Editor uses to adjust
how the data is shown. The original data is not affected; only this particular view of the data is adjusted, or shaped.
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The steps you specify (such as rename a table, transform a data type, or delete columns) are recorded by Query
Editor, and each time this query connects to the data source, those steps are carried out.
After you import data, you might find errors. In Query Editor, you can find these errors and fix them, or change the
data types of columns of data as needed. To learn more, see Shape and combine data in Power BI Desktop at
powerbi.microsoft.com/en-us/documentation/powerbi-desktop-shape-and-combine-data.

Model your data
Power BI Desktop provides advanced data modeling features like auto-detect and manual relationships, custom
measures, calculated columns, data categorization, and sort by column. Data View makes seeing the data in your
model easy, and with Relationship View, you get a customizable diagram view of all your tables and the relationships
between them.

Create reports
A report is a multi-perspective view into your data, with visualizations that represent different findings and insights
from that data. A report can have a single visualization, or pages full of visualizations.

Figure 6. A Power BI report
See Report view in Power BI Desktop at powerbi.microsoft.com/en-us/documentation/powerbi-desktop-report-view to
learn more about creating compelling and powerful reports.

View reports in the navigation pane
Power BI can have more than one report—as you add reports, their titles are added to the list. Note that only one
report can be open at a time.

Power BI Mobile for productivity on the go
Stay connected to your data from anywhere, anytime with Microsoft Power BI Mobile. Give viewing and interacting
with your Power BI dashboards, KPIs, and various reports a try on your mobile device—be it iOS (iPad or iPhone),
Apple Watch, Android phone, or a Windows 10 device.
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For a comprehensive guide, see Power BI apps for mobile devices at powerbi.microsoft.com/enus/documentation/powerbi-power-bi-apps-for-mobile-devices. The following list provides links to content about the
mobile devices that support Power BI.


Learn about the iPhone app (Power BI for iOS): Get started with the Power BI for iOS app on an iPhone or iPod
Touch



Learn about the iPad app (Power BI for iOS): Get started with the iPad app (Power BI for iOS)



Learn about Power BI app for Android phones: Get started with the Power BI for Android app



Learn about Power BI app for Windows 10 devices: Get started with the Power BI mobile app for Windows 10

For more information
Guided learning for Power BI
powerbi.microsoft.com/en-us/guided-learning

Power BI Service—basic concepts
powerbi.microsoft.com/en-us/documentation/powerbi-service-basic-concepts

Getting started with Power BI Desktop
powerbi.microsoft.com/en-us/documentation/powerbi-desktop-getting-started

Power BI Mobile Apps
powerbi.microsoft.com/en-us/documentation/powerbi-power-bi-apps-for-mobile-devices
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